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Web application development 
The DOT NET (.NET) created by Microsoft is a software development platform focused on rapid application development (RAD), platform 
independence and network transparency. DOT NET (.NET) is Microsoft's strategic initiative for server and desktop development for the next 
decade. According to Microsoft, DOT NET (.NET) includes many technologies designed to facilitate rapid development of Internet and 
intranet applications. 
 
DOT NET (.NET) has brought new functionalities and tools to the application programming interface (API). These innovations allow 
development of applications for both Windows and the web as well as components and services (web services). .NET provides a new 
reflective, object-oriented API. .NET is designed to be sufficiently generic so that many different high-level languages can be compiled. 

Shrigen Technologies has Expertise in .NET 
 
Shrigen provides design, development and integration business solutions based on the DOT NET (.NET) platform. Our team of experienced 
Microsoft certified DOT NET (.NET) architects, analysts and developers delivers a wide range of comprehensive solutions in the following 
key areas. 
 
 

x DOT NET (.NET) Desktop Application Development 
x ASP.NET (Web) Application Development 
x DOT NET (.NET) Software Product Development 
x Migration of Web and Desktop Applications to DOT NET (.NET) 
x Web Services Based DOT NET (.NET) Application Development 
x Mobile applications based on DOT NET (.NET) Compact Framework 

ASP.NET Web Forms 
ASP.NET is a development framework for building web pages and web sites with HTML, CSS, 
JavaScript and server scripting. 

ASP.NET supports three different development models: 
Web Pages, MVC (Model View Controller), and Web Forms. 

What is Web Forms? 

Web Forms is one of the 3 programming models for creating ASP.NET web sites and web 
applications. 

The other two programming models are Web Pages and MVC (Model, View, Controller). 

Web Forms is the oldest ASP.NET programming model, with event driven web pages written as a 
combination of HTML, server controls, and server code. 

Web Forms are compiled and executed on the server, which generates the HTML that displays 
the web pages. 

Web Forms comes with hundreds of different web controls and web components to build user-
driven web sites with data access. 
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Visual Studio Express 2012/2010 

Visual Studio Express is a free version of Microsoft Visual Studio. 

Visual Studio Express is a development tool tailor made for Web Forms (and MVC). 

Visual Studio Express contains: 

x MVC and Web Forms 
x Drag-and-drop web controls and web components 
x A web server language (Razor using VB or C#) 
x A web server (IIS Express) 
x A database server (SQL Server Compact) 
x A full web development framework (ASP.NET) 
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Working With XML File in ASP.NET 

Introduction 

Extensible Markup Language (XML) strores and transports data. If we use a XML file to store 
the data then we can do operations with the XML file directly without using the database. 
The XML format is supported for all applications. It is independent of all software 
applications and it is accessible by all applications. Here is an example that shows how to 
insert the data into the XML file and how to retrieve the data from the XML file; also how to 
bind the data into tha DataList using ASP.NET. For this the following procedure can be used. 

Step 1: First start Visual Studio 2010 by clicking "File" -> "New" -> "Web Site..." then click 
on "ASP.NET Web Site". Now write the following inline code that will design your web page. 

<html xmlns="http://www.w3.org/1999/xhtml"> 
<head runat="server"> 
   <title></title> 
   <style type="text/css"> 
        .style1 
        { 
           width: 40%; 
           border-style: solid; 
           border-width: 1px; 
           background-color:Silver; 
           height: 152px; 
        } 
        .style2 
        { 
           width: 295px; 
        } 
        .style3 
        { 
           width: 754px; 
        } 
   </style> 
</head> 
<body> 
   <form id="form1" runat="server"> 
   <div> 
       <table class="style1"> 
           <tr> 
               <td class="style2"> 
                   &nbsp;</td> 
               <td class="style3"> 
                   &nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;Employee_Info
rmation</td> 
           </tr> 
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           <tr> 
               <td class="style2"> 
                    Name:</td> 
               <td class="style3"> 
                   <asp:TextBox ID="TextBox1" runat="server"></asp:TextBox> 
               </td> 
           </tr> 
           <tr> 
               <td class="style2"> 
                    Emp_Id:</td> 
               <td class="style3"> 
                   <asp:TextBox ID="TextBox2"runat="server"></asp:TextBox> 
               </td> 
           </tr> 
           <tr> 
                <td class="style2"> 
                    Qualification:</td> 
               <td class="style3"> 
                   <asp:DropDownList ID="DropDownList1" runat="server" Height="22px" Width
="132px"> 
                       <asp:ListItem>--SELECT--</asp:ListItem> 
                       <asp:ListItem>MCA</asp:ListItem> 
                       <asp:ListItem>BCA</asp:ListItem> 
                       <asp:ListItem>MBA</asp:ListItem> 
                       <asp:ListItem>BBA</asp:ListItem> 
                       <asp:ListItem>BTech</asp:ListItem> 
                       <asp:ListItem>MTech</asp:ListItem> 
                   </asp:DropDownList> 
               </td> 
           </tr> 
           <tr> 
               <td class="style2"> 
                   &nbsp;</td> 
               <td class="style3"> 
                   <asp:Button ID="Button1" runat="server" Text="Submit" onclick="Button1_Cl
ick"/> 
                   <asp:Button ID="Button2" runat="server" onclick="Button2_Click" Text="Sho
w"/> 
               </td> 
           </tr> 
       </table> 
       <asp:DataList ID="DataList1" runat="server" BackColor="#DEBA84" BorderColor="#D
EBA84" 
 
BorderStyle="None" BorderWidth="1px" CellPadding="3" CellSpacing="2" GridLines="Both"
RepeatDirection="Horizontal" 
style="margin-right: 32px"> 
           <FooterStyle BackColor="#F7DFB5" ForeColor="#8C4510"/> 
           <HeaderStyle BackColor="#A55129" Font-Bold="True"ForeColor="White"/> 
           <ItemStyle BackColor="#FFF7E7" ForeColor="#8C4510"/> 
           <SelectedItemStyle BackColor="#738A9C" Font-Bold="True" ForeColor="White"/> 
           <ItemTemplate> 
           <hrsize=0 /> 
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             Name:<%#DataBinder.Eval(Container.DataItem,"name")%><br/> 
 
             Emp_id:<%#DataBinder.Eval(Container.DataItem,"Emp_id")%></a><br/> 
             Qualification:<%#DataBinder.Eval(Container.DataItem,"Qualification")%><br/> 
           </ItemTemplate> 
       </asp:DataList> 
   <br /> 
   </div> 
   </form> 
</body> 
</html> 
 
The design will look as in the following image: 
  

 
  
  
Step 2: Add a XML file by clicking "File" -> "Add new item" then click on "XML file". Name 
this XML file Sample.xml. Put the following code in the XML file: 
  
<?xml version="1.0"encoding="utf-8"?> 
<EmployeeInformation> 
</EmployeeInformation> 
  
Step 3: After that add the following namespaces in the code behind: 
  
using System.Data; 
using System.Xml; 
 
 
Step 4: Now write the following code in the code behind file: 
 
public partial classDefault2 : System.Web.UI.Page 
{ 
 protected void Page_Load(object sender, EventArgs e) 
    { 
      if (!IsPostBack) 
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       { 
           //Bind xml data to datalist 
           BindDatalist(); 
       } 
    } 
  private void BindDatalist() 
    { 
       XmlTextReader xmlreader =new XmlTextReader(Server.MapPath("Employee.xml")); 
       DataSet ds = newDataSet(); 
        ds.ReadXml(xmlreader); 
        xmlreader.Close(); 
       if (ds.Tables.Count != 0) 
        { 
            DataList1.DataSource = ds; 
            DataList1.DataBind(); 
        } 
        else 
        { 
            DataList1.DataSource = null; 
            DataList1.DataBind(); 
        } 
    } 
} 
 
 
Step 5: Write the following code in the click event of the submit button, so that the data 
that is entered is stored in the XML File: 
  
protected void Button1_Click(object sender, EventArgs e) 
    { 
       XmlDocument xmldoc =new XmlDocument(); 
        xmldoc.Load(Server.MapPath("Employee.xml")); 
        BindDatalist(); 
    } 
 
Step 6: Write the following code in the click event of the show button. Now the data stored 
in the XML file can be shown. 
 
protected void Button2_Click(object sender, EventArgs e) 
    { 
       XmlDocument xmldoc =new XmlDocument(); 
        xmldoc.Load(Server.MapPath("Employee.xml")); 
       XmlElement parentelement = xmldoc.CreateElement("Details"); 
       XmlElement name = xmldoc.CreateElement("Name"); 
        name.InnerText = TextBox1.Text; 
       XmlElement Emp_id = xmldoc.CreateElement("Emp_id"); 
        Emp_id.InnerText = TextBox2.Text; 
       XmlElement Qualification = xmldoc.CreateElement("Qualification"); 
        Qualification.InnerText = DropDownList1.SelectedItem.Text; 
        parentelement.AppendChild(name); 
        parentelement.AppendChild(Emp_id); 
        parentelement.AppendChild(Qualification); 
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        xmldoc.DocumentElement.AppendChild(parentelement); 
        xmldoc.Save(Server.MapPath("Employee.xml")); 
        BindDatalist(); 
    } 
 
 
Step 7: Run your application by pressing F5. The output is: 
  

 
  
Step 8 : See your sample.xml file, it will include the data that I entered at the run time like 
this: 
  
<?xmlversion="1.0"encoding="utf-8"?> 
<EmployeeInformation> 
  <Details> 
    <Name>Richa</Name> 
    <Emp_id>1</Emp_id> 
    <Qualification>MCA</Qualification> 
  </Details> 
</EmployeeInformation> 
 
Summary: In this article I use a XML file so that the data is stored and retrieved in XML 
using the Datalist in ASP.NET. 
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Parsing XML Files in .NET Using C# 
Parsing XML files is an unglamorous task that can be time consuming and tricky. In the days 
before .NET, programmers were forced to read XML as a text file line by line and then use string 
functions and possibly regular expressions. This is a time-consuming and error-prone process, 
and just not very much fun. 

While I was writing .NET test automation that had test case data stored in XML files, I discovered 
that the .NET Framework provides powerful new ways of parsing XML. But in conversations with 
colleagues, I also discovered that there are a variety of opinions on which way of parsing XML 
files is the best. 

I set out to determine how many different ways there are to parse XML using .NET and to 
understand the pros and cons of each technique. After some experimentation, I learned that 
there are five fundamentally different ways to parse XML, and that the "best" method depends 
both on the particular development situation you are in and on the style of programming you 
prefer. 

In the sections that follow, I will demonstrate how to parse a testCases.xml file using five 
different techniques. Each technique is based on a different .NET Framework class and its 
associated methods: 

x XmlTextReader 
x XmlDocument 
x XPathDocument 
x XmlSerializer 
x DataSet 

After I explain each technique so you can modify my examples to suit your needs, I will give you 
guidance on which technique should be used in which situation. Knowing these five methods for 
parsing XML files will be a valuable addition to your .NET skill set. I'm assuming that you're 
familiar with C#, VS.NET, the creation and use of class libraries, and have a working knowledge 
of XML files. 

The XML File to Parse and the Goal 

Let's examine the testCases.xml file that we will use for all five parsing examples. The file 
contents are shown in Listing One. 

Listing One: XML file to parse 

? 

1 

2 

3 

4 

5 

<?xml version="1.0" encoding="utf-8" ?>  

<suite> 

  

  <testcase id="001" kind="bvt"> 

    <inputs> 
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6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

21 

22 

23 

24 

25 

26 

27 

28 

      <arg1>4</arg1> 

      <arg2>7</arg2> 

    </inputs> 

    <expected>11.00</expected> 

  </testcase> 

  

  <testcase id="002" kind="drt"> 

    <inputs> 

      <arg1>9</arg1> 

      <arg2>6</arg2> 

    </inputs> 

    <expected>15.00</expected> 

  </testcase> 

  

  <testcase id="003" kind="bvt"> 

    <inputs> 

      <arg1>5</arg1> 

      <arg2>8</arg2> 

    </inputs> 

    <expected>13.00</expected> 

  </testcase> 

< 

/suite> 

Note that each of the three test cases has five data items: id, kind, arg1, 
arg2, andexpected. Some of the data is stored as XML attributes (id and kind), 
and arg1 and arg2are stored as XML elements two levels deep relative to the root node 
(suite). Extracting attribute data and dealing with nested elements are key tasks regardless of 
which parsing strategy we use. 
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The goal is to parse our XML test cases file and extract the data into memory in a form that we 
can use easily. The memory structure we will use for four of the five parsing methods is shown in 
Listing Two. (The method that employs an XmlSerializer object requires a slightly 
different memory structure and will be presented later.) 

Listing Two: CommonLib.dll definitions 

? 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

21 

22 

23 

using System; 

using System.Collections; 

  

namespace CommonLib 

{ 

  public class TestCase 

  { 

    public string id; 

    public string kind; 

    public string arg1; 

    public string arg2; 

    public string expected; 

  }   

  

  public class Suite 

  { 

    public ArrayList items = new ArrayList(); 

    public void Display() 

    { 

      foreach (TestCase tc in items) 

      { 

        Console.Write(tc.id + " " + tc.kind + " " + tc.arg1 + 
" "); 
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24 

25 

26 

27 

        Console.WriteLine(tc.arg2 + " " + tc.expected); 

      } 

    } 

  } // class Suite 

} // ns  

Because four of the five techniques will use these definitions, for convenience we can put the 
code in a .NET class library named "CommonLib." A TestCase object will hold the five data 
parts of each test case, and a Suite object will hold a collection of TestCase objects and 
provide a way to display it. 

Once the XML data is parsed and stored, the result can be represented as shown in >Figure 1. 
The data can now be easily accessed and manipulated. 

Figure 1 XML data stored in memory 

 

 

Parsing XML with XmlTextReader 

Of the five ways to parse an XML file, the most traditional technique is to use 
theXmlTextReader class. The example code is shown in Listing Three. 

Listing Three: Parsing XML using XmlTextReader 

? 

1 

2 

3 

4 

using System; 

using System.Xml; 

using CommonLib; 
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5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

21 

22 

23 

24 

25 

26 

27 

28 

29 

30 

31 

namespace Run 

{ 

  class Class1 

  { 

    [STAThread] 

    static void Main(string[] args) 

    { 

      CommonLib.Suite s = new CommonLib.Suite(); 

              

      XmlTextReader xtr = new 
XmlTextReader("..\\..\\..\\..\\testCases.xml"); 

      xtr.WhitespaceHandling = WhitespaceHandling.None; 

      xtr.Read(); // read the XML declaration node, advance to <suite> tag 

  

      while (!xtr.EOF) //load loop 

      { 

        if (xtr.Name == "suite" && !xtr.IsStartElement()) break; 

  

        while (xtr.Name != "testcase" || !xtr.IsStartElement() )  

          xtr.Read(); // advance to <testcase> tag 

  

        CommonLib.TestCase tc = new CommonLib.TestCase(); 

        tc.id = xtr.GetAttribute("id"); 

        tc.kind = xtr.GetAttribute("kind"); 

        xtr.Read(); // advance to <inputs> tag 

        xtr.Read(); // advance to <arg1> tag 

        tc.arg1 = xtr.ReadElementString("arg1"); // consumes the </arg1> tag 

        tc.arg2 = xtr.ReadElementString("arg2"); // consumes the </arg2> tag 
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32 

33 

34 

35 

36 

37 

38 

39 

40 

41 

42 

43 

44 

        xtr.Read(); // advance to <expected> tag 

        tc.expected = xtr.ReadElementString("expected"); // consumes the 
</expected> tag 

        // we are now at an </testcase> tag 

        s.items.Add(tc); 

        xtr.Read(); // and now either at <testcase> tag or </suite> tag 

      } // load loop 

  

      xtr.Close(); 

      s.Display(); // show the suite of TestCases 

  

    } // Main() 

  } // class Class1 

 } // ns Run 

After creating a new C# Console Application Project in Visual Studio .NET, we add a Project 
Reference to the CommonLib.dll file that contains definitions 
for TestCase and Suite classes. We start by creating a Suite object to hold the XML data 
and an XmlTextReader object to parse the XML file. 

The key to understanding this technique is to understand 
the Read() andReadElementString() methods of XmlTextReader. To 
an XmlTextReader object, an XML file is a sequence of nodes. For example, 

? 

1 

2 

3 

4 

<?xml version="1.0" ?> 

<foo> 

  <bar>99</bar> 

</foo> 

has 6 nodes: the XML declaration, <foo>, <bar>, 99, </bar>, and </foo>. 

The Read() method advances one node at a time. Unlike many Read() methods in other 
classes, the System.XmlTextReader.Read() does not return significant data. 
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TheReadElementString() method, on the other hand, returns the data between the 
begin and end tags of its argument, and advances to the next node after the end tag. Because 
XML attributes are not nodes, we have to extract attribute data using 
the GetAttribute()method. 

Figure 2 shows the output of running this program. You can see that we have successfully parsed 
the data from testCases.xml into memory. 

Figure 2 Output from the XmlTextReader technique 

 
 

 

The statement xtr.WhitespaceHandling = WhitespaceHandling.None; is 
important because without it you would have to Read() over newline characters and blank 
lines. 

The main loop control structure that I used is not elegant but is more readable than the 
alternatives: 

? 

1 

2 

3 

while (!xtr.EOF) //load loop 

      { 

        if (xtr.Name == "suite" && !xtr.IsStartElement()) 
break; 

It exits when we are at EOF or an </suite> tag. 

When marching through the XML file, you can either Read() your way one node at a time or 
get a bit more sophisticated with code like the following: 

www.studentsfocus.com



Sri Vidya College of  Engineering & Technology   Course Material [Lecture Notes] 

CS6001 C# AND .NET PROGRAMMING  Unit IV 

? 

1 

2 

while (xtr.Name != "testcase" || !xtr.IsStartElement() )  

          xtr.Read();          // advance to <testcase> tag 

The choice of technique you use is purely a matter of style. 

Parsing an XML file with XmlTextReader has a traditional, pre-.NET feel. You walk 
sequentially through the file using Read(), and extract data 
with ReadElementString() andGetAttribute(). Using XmlTextReader is 
straightforward and effective and is appropriate when the structure of your XML file is relatively 
simple and consistent. Compared to other techniques we will see in this 
article, XmlTextReader operates at a lower level of abstraction, meaning it is up to you as a 
programmer to keep track of where you are in the XML file andRead() correctly. 

Parsing XML with XmlDocument 

The second of five ways to parse an XML file is to use the XmlDocument class. 
The example code is shown in Listing Four. 

Listing Four: Parsing XML using XmlDocument 

? 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

using System; 

using System.Xml; 

using CommonLib; 

  

namespace Run 

{ 

  class Class1 

  { 

    [STAThread] 

    static void Main(string[] args) 

    { 

      CommonLib.Suite s = new CommonLib.Suite(); 
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14 

15 

16 

17 

18 

19 

20 

21 

22 

23 

24 

25 

26 

27 

28 

29 

30 

31 

32 

33 

34 

35 

36 

37 

38 

39 

40 

      XmlDocument xd = new XmlDocument(); 

      xd.Load("..\\..\\..\\..\\testCases.xml"); 

        

      XmlNodeList nodelist = xd.SelectNodes("/suite/testcase"); // get all <testcase> nodes 

  

      foreach (XmlNode node in nodelist) // for each <testcase> node 

      { 

        CommonLib.TestCase tc = new CommonLib.TestCase(); 

          

        tc.id = node.Attributes.GetNamedItem("id").Value; 

        tc.kind = node.Attributes.GetNamedItem("kind").Value; 

  

        XmlNode n = node.SelectSingleNode("inputs"); // get the one <input> node 

        tc.arg1 = n.ChildNodes.Item(0).InnerText; 

        tc.arg2 = n.ChildNodes.Item(1).InnerText; 

  

        tc.expected = node.ChildNodes.Item(1).InnerText; 

  

        s.items.Add(tc); 

      } // foreach <testcase> node 

        

      s.Display(); 

  

    } // Main() 

  } // class Class1 

  

} // ns Run 
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XmlDocument objects are based on the notion of XML nodes and child nodes. 
Instead of sequentially navigating through a file, we select sets of nodes with 
the SelectNodes()method or individual nodes with 
the SelectSingleNode() method. Notice that because XML attributes are 
not nodes, we must get their data with 
an Attributes.GetNamedItem()method applied to a node. 

After loading the XmlDocument, we fetch all the test case nodes at once with: 

? 

1 XmlNodeList nodelist = xd.SelectNodes("/suite/testcase"); 

Then we iterate through this list of nodes and fetch each <input> node with: 

? 

1 XmlNode n = node.SelectSingleNode("inputs"); 

and then extract the arg1 (and similarly arg2) value using: 

? 

1 tc.arg1 = n.ChildNodes.Item(0).InnerText; 

In this statement, n is the <inputs> node; ChildNodes.Item(0) is the first 
element of<inputs>, i.e., <arg1> and InnerText is the value 
between <arg1> and </arg1>. 

The output from running this program is shown in Figure 3. Notice it is identical to 
the output from running the XmlTextReader technique and, in fact, all the 
other techniques presented in this article. 

Figure 3 Output from the XmlDocument technique 
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The XmlDocument class is modeled on the W3C XML Document Object Model 
and has a different feel to it than many .NET Framework classes that you are 
familiar with. Using theXmlDocument class is appropriate if you need to extract 
data in a nonsequential manner, or if you are already 
using XmlDocument objects and want to maintain a consistent look and feel to 
your application's code. 

Let me note that in discussions with my colleagues, there was often some confusion 
about the role of the XmlDataDocument class. It is derived from 
the XmlDocument class and is intended for use in conjunction 
with DataSet objects. So, in this example, you could use 
theXmlDataDocument class but would not gain anything. 

Parsing XML with XPathDocument 

The third technique to parse an XML file is to use the XPathDocument class. 
The example code is shown in Listing Five. 

Listing Five: Parsing XML using XPathDocument 
1 

2 

3 

4 

5 

6 

using System; 

using System.Xml.XPath; 

using CommonLib; 

  

namespace Run 

{ 
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8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

21 

22 

23 

24 

25 

26 

27 

28 

29 

30 

31 

32 

33 

  class Class1 

  { 

    [STAThread] 

    static void Main(string[] args) 

    { 

      CommonLib.Suite s = new CommonLib.Suite(); 

  

      XPathDocument xpd = new XPathDocument("..\\..\\..\\..\\testCases.xml"); 

      XPathNavigator xpn = xpd.CreateNavigator(); 

      XPathNodeIterator xpi = xpn.Select("/suite/testcase"); 

        

      while (xpi.MoveNext()) // each testcase node 

      { 

        CommonLib.TestCase tc = new CommonLib.TestCase(); 

        tc.id = xpi.Current.GetAttribute("id", xpn.NamespaceURI); 

        tc.kind = xpi.Current.GetAttribute("kind", xpn.NamespaceURI); 

  

        XPathNodeIterator tcChild = 
xpi.Current.SelectChildren(XPathNodeType.Element); 

        while (tcChild.MoveNext()) // each part (<inputs> and <expected>) of <testcase> 

        { 

          if (tcChild.Current.Name == "inputs") 

          { 

            XPathNodeIterator tcSubChild = 
tcChild.Current.SelectChildren(XPathNodeType.Element); 

            while (tcSubChild.MoveNext()) // each part (<arg1>, <arg2>) of <inputs> 

            { 

              if (tcSubChild.Current.Name == "arg1") 
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34 

35 

36 

37 

38 

39 

40 

41 

42 

43 

44 

45 

46 

47 

48 

49 

50 

                tc.arg1 = tcSubChild.Current.Value; 

              else if (tcSubChild.Current.Name  == "arg2") 

                tc.arg2 = tcSubChild.Current.Value; 

            } 

          } 

          else if (tcChild.Current.Name == "expected") 

            tc.expected = tcChild.Current.Value; 

        } 

        s.items.Add(tc); 

  

      } // each testcase node 

        

      s.Display(); 

        

    } // Main() 

  } // class Class1 

  

} // ns Run 

Using an XPathDocument object to parse XML has a hybrid feel that is part 
procedural (as inXmlTextReader) and part functional (as in XmlDocument). 
You can select parts of the document using the Select() method of 
an XPathNavigator object and also move through the document using 
the MoveNext() method of an XPathNodeIterator object. 

After loading the XPathDocument object, we get what is in essence a reference 
to the first <testcase> node into an XPathNodeIterator object with: 

? 

1 XPathNavigator xpn = xpd.CreateNavigator(); 
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2 XPathNodeIterator xpi = xpn.Select("/suite/testcase"); 

Because XPathDocument does not maintain "node identity," we must iterate 
through each<testcase> node with this loop: 

? 

1 while (xpi.MoveNext()) 

Similarly, we have to iterate through the children with: 

? 

1 while (tcChild.MoveNext()) 

The XPathDocument class is optimized for XPath data model queries. So using 
it is particularly appropriate when the XML file to parse is deeply nested or has a 
complex structure. You might also consider using XPathDocument if other parts 
of your application code use that class so that you maintain a consistent coding look 
and feel. 

Parsing XML with XmlSerializer 

The fourth technique we will use to parse an XML file is 
the XmlSerializer object. The example code is shown in Listing Six. 

Listing Six: Parsing XML using XmlSerializer 

? 

1 

2 

3 

4 

5 

6 

7 

8 

using System; 

using System.Xml.Serialization; 

using System.IO; 

using SerializerLib; // defines a Suite class compatible with testCases.xml 

  

namespace Run 

{ 

  class Class1 
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9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

  { 

    [STAThread] 

    static void Main(string[] args) 

    { 

      XmlSerializer xs = new XmlSerializer(typeof(Suite)); 

      StreamReader sr = new 
StreamReader("..\\..\\..\\..\\testCases.xml"); 

      SerializerLib.Suite s = 
(SerializerLib.Suite)xs.Deserialize(sr); 

      sr.Close(); 

      s.Display(); 

    }  

  } // class Class1 

} // ns Run 

Using the XmlSerializer class is significantly different from using any of the 
other classes because the in-memory data store is different from the 
CommonLib.Suite we used for all other examples. In fact, observe that pulling the 
XML data into memory is accomplished in a single statement: 

? 

1 
SerializerLib.Suite s = 
(SerializerLib.Suite)xs.Deserialize(sr); 

I created a class library named "SerializerLib" to hold the definition for 
a Suite class that corresponds to the testCases.xml file so that 
the XmlSerializer object can store the XML data into it. The trick, of course, 
is to set up this Suite class. 

Creating the Suite class is done with the help of the xsd.exe command-line tool. 
You will find it in your Program Files\Microsoft Visual Studio 
.NET\FrameworkSDK\bin folder. I used xsd.exe to generate a Suite class and 
then modified it slightly by changing some names and adding 
aDisplay() method. 
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The screen shot in Figure 4 shows how I generated the file testCases.cs, which 
contains aSuite definition that you can use directly or modify as I did. Listings 
Seven and Eight show the classes generated by XSD and my modified classes in the 
SerializerLib library. 

Figure 4 Generating testCases.cs definitions using XSD 

 

 

Listing Seven: XSD-generated suite definition 

? 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

// This source code was auto-generated by xsd, Version=1.0.3705.288. 

//  

using System.Xml.Serialization; 

  

[System.Xml.Serialization.XmlRootAttribute("suite", Namespace="", 
IsNullable=false)] 

public class suite { 

    [System.Xml.Serialization.XmlElementAttribute("testcase")] 

    public suiteTestcase[] Items; 

} 

  

public class suiteTestcase { 

    public string expected; 
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13 

14 

15 

16 

17 

18 

19 

20 

21 

22 

23 

24 

    [System.Xml.Serialization.XmlElementAttribute("inputs")] 

    public suiteTestcaseInputs[] inputs; 

    [System.Xml.Serialization.XmlAttributeAttribute()] 

    public string id; 

    [System.Xml.Serialization.XmlAttributeAttribute()] 

    public string kind; 

} 

  

public class suiteTestcaseInputs { 

    public string arg1; 

    public string arg2; 

} 

Listing Eight: Modified suite definition 

? 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

using System; 

using System.Xml.Serialization; 

  

namespace SerializerLib 

{ 

  [XmlRootAttribute("suite")] 

  public class Suite  

  { 

    [XmlElementAttribute("testcase")] 

    public TestCase[] items; // changed name from xsd-generated code 

    public void Display() // added to xsd-generated code 

    { 

      foreach (TestCase tc in items) 
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14 

15 

16 

17 

18 

19 

20 

21 

22 

23 

24 

25 

26 

27 

28 

29 

30 

31 

32 

33 

34 

35 

36 

37 

      { 

        Console.Write(tc.id + " " + tc.kind + " "  + tc.inputs.arg1 
+ " "); 

        Console.WriteLine(tc.inputs.arg2 + " " + tc.expected); 

      } 

    } 

  } 

  

  public class TestCase  // changed name from xsd-generated code 

  { 

    [XmlAttributeAttribute()] 

    public string id; 

    [XmlAttributeAttribute()] 

    public string kind; 

    [XmlElementAttribute("inputs")] 

    public Inputs inputs; // change from xsd-generated code: no array 

    public string expected; 

  } 

  

  public class Inputs // changed name from xsd-generated code 

  { 

    public string arg1; 

    public string arg2; 

  } 

} 

Using the XmlSerializer class gives a very elegant solution to the problem of 
parsing an XML file. Compared with the other four techniques in this 
article, XmlSerializer operates at the highest level of abstraction, meaning 
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that the algorithmic details are largely hidden from you. But this gives you less 
control over the parsing and lends an air of magic to the process. 

Most of the code I write is test automation, and using XmlSerializer is my 
default technique for parsing XML. XmlSerializer is most appropriate for 
situations not covered by the other four techniques in this article: fine-grained 
control is not required, the application program does not use 
other XmlDocument objects, the XML file is not deeply nested, and the 
application is not primarily an ADO .NET application (as we will see in our next 
example). 
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How To Create a Virtual Directory in 
Internet Information Services (IIS) 
 

Create Virtual Directories in IIS 5.0 

1. Click Start, point to Programs, click to select Administrative Tools, and then click Internet Services Manager. 
2. Expand the server name. 

3. In the left pane, right-click Default Web Site, point to New, and then click Virtual Directory. 
4. In the first screen of the Virtual Directory Creation Wizard, type an alias, or name, for the virtual directory (such 

as MyWebData), and then click Next. 
5. In the second screen, click Browse. Locate the content folder that you created to hold the content. Click Next. 
6. In the third screen, click to select Read and Run scripts (such as ASP). Make sure that the other check boxes 

are cleared. Click Finish to complete the wizard. 
7. For ASP content, you may want to confirm that an application was created. To do this, right-click the new virtual 

directory, and then click Properties. 
8. On the Virtual Directory tab, make sure that the virtual directory name is listed in the Application Name box 

under Application Settings. If it is not, click Create. Note that the application name does not have to match 
the virtual directory alias. 

9. Close the Properties dialog box. 
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Creating virtual directories and application pools 
in IIS 7.5 and 7.0 
 
To create a virtual directory: 

1. Open IIS Manager 

x On Windows 7: Open Start -> Control Panel -> System and Security category -> Administrative 
Tools -> Internet Information Services (IIS) Manager. 

x On Windows Server 2008 or Windows Vista: Open Start -> Control Panel -> System and 
Maintenance category -> Administrative Tools ->Internet Information Services (IIS) Manager. 

2. Expand local computer -> Sites -> right-click on Default Web Site (or other website if you're 
running multiple websites on the same computer) and choose Add Virtual Directory...  
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x An Add Virtual Directory dialog appears. 

3. Enter the Virtual Directory Alias. If you want the website to run 
as http://localhost/KenticoCMSDemo, enter alias KenticoCMSDemo. 

4. Type a path or browse to the physical directory that contains the chosen directory. 

 
5. Click OK. 

x The system creates a new virtual directory. 

6. Right-click the virtual directory and choose Convert to Application. 

x An Add Application dialog appears. 

7.Click Select... and choose the ASP.NET v4.0 application pool from the drop-down menu. 
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8. Click OK. 

The system converts the virtual directory to an application. 

Alternatively, you can create an application in one step by right-clicking a web site and 
choosing Add Application... and filling the required information in the Add Application dialog as 
mentioned above. 

Configuring application pools in IIS 7 and IIS 7.5 

Application Pools provide you with additional level of website management. They are supported only 
by Windows Server 2003/2008/Vista/7. You can configure them in the Internet Information 
Services (IIS) Manager under local computer -> Application Pools.
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You can check and change the assigned application pool by right-clicking an application under local 
computer -> Sites -> Default Web Site (or other web site) and selecting Manage Application -> 
Advanced Settings... 
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You can set the Recycling and other options by right-clicking on an application pool under local 
computer -> Application Pools and selecting Advanced Settings.... 
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Recommended Application Pool Configuration 

x It's highly recommended that you run Kentico in a separate application pool. If you share the pool 
with other websites, the system may behave unpredictably. 

x We do not recommend to run multiple websites in a single pool. 
x It's recommended that you specify some value in the Recycle worker processes on 

the Recycling tab. This value shouldn't be too short (less than60 minutes) or too long (more 
than 1440 minutes/1 day). Setting this value ensures that the memory is recycled and the 
application is automatically recovered from failures by regular restart. If your website 
freezes time to time, you can temporarily set the value to 30 minutes to ensure that the website is 
restarted automatically. Short intervals may lead to high server load and slow response since after 
each recycling, the application needs to be restarted and data reloaded to the cache. 
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x It's recommended that you do not limit the maximum virtual or used memory. If you need to use 
some value, use at least 100 MB. If your website is being restarted too often, it may be caused by 
low maximum memory limit. You can check the frequency of application restarts in KenticoEvent log. 

x The Maximum number of worker processes on the Performance tab must be set to 1. If you set a 
higher value, the worker processes will not be synchronized and Kentico website will not work 
correctly. This may lead to unexpected caching of content and system objects. 

x You can configure the user account under which the application runs on the Identity tab. This 
information is useful if you need to troubleshoot issues with permissions, such as disk write 
permissions. 

x Kentico does not support Web garden. Therefore, the Maximum number of worker 
processes has to be set to 1. 
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Understanding Session Management 
Techniques in ASP.NET 

Introduction 
In this article we will try to see what are the different ways we can manage 
sessions in an ASP.NET application. When should we use which techniques and 
what are the pros and cons of using each technique. 

Background 
The basic stateless nature of web sites and web applications are rather very 
confusing to anyone who is starting with web development. ASP.NET provides 
various ways of handling the states. The basic overview of all the state 
management techniques can be found here. 

In this article we will specifically be discussing the Session management 
techniques. Session are the server side method of managing the state of an 
application i.e. all the web applications' state related info will be stored on server 
side if we use this technique. The benefit of having this technique is that since we 
are keeping all the state related information on server, the request and response 
becomes lightweight. Also, the chances of someone intercepting or changing this 
data is also reduced. But this technique does involve more resource usage on the 
server.  

The advantages of using Session State are 

x Better security 
x Reduced bandwidth 

The disadvantages of using Session state are 

x More resource consumption of server. 
x Extra code/care if a Web farm is used(we will discuss this shortly) 
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Let us start looking into how we can use the Session state in our application and 
see how we can configure it to use various techniques. 

Getting to know the Players  
Using Session State 

ASP.NET allows us to save values using Session state. It is a global storage 
mechanism that is accessible from all pages in the Web application. Session state 
is stored in the Session key/value dictionary. This information will be user 
specific i.e. for each user separate dictionary will be created and no one can 
access other session information. below is the Example usage of sessions. 

Hide   Copy Code 

//global.asax 
void Session_Start(object sender, EventArgs e) 
{ 
    // Code that runs when a new session is started 
    Session["number"] = 0; 
} 
 
// Web forms 
Session["number"] = Convert.ToInt32(Session["number"]) + 1; 
 
Label6.Text = Session["number"].ToString();s 

Enumerating Session Management Techniques 

Before we proceed, let us see what all session management techniques are 
present in the ASP.NET framework. 

x In-Proc. 
x SQLServer. 
x StateServer. 

How to configure Sessions 

To configure the session management we need to specify the settings in 
the web.config file. Typical settings inweb.config looks like: 
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Hide   Copy Code 

<sessionState mode="InProc"  
                stateConnectionString="tcpip=127.0.0.1:42424"  
                sqlConnectionString="Data Source=.\SQLEXPRESS;Trusted_Connection=Yes;"  
                cookieless="false"  
                timeout="100"/> 

Let us see what each of these attributes mean. 

mode 
This specifies the type of session management we want 
to use. it could be InProc,SQLServer, and StateServer 

stateConnectionString 
If we use StateServer as session management technique 
then this specifies the location of the server that is 
handling the session data. 

sqlConnectionString 
If we use SQLServer as session management technique 
then this specifies the databaseconnectionstring that will 
store the session data. 

cookieless 
This specifies whether we will be using cookies to identify 
sessions or we want session info appended in URL. It 
could be true or false. 

timeout 
This specifies the time for which the session should be 
active. after this much time of inactivity the session will 
expire.  

Single server vs Web Farm 

Website require a hosting server. If we have a high traffic website then to 
improve the performance we might choose to have multiple web servers. In case 
we want multiple web servers(Web Farm), We need to have all the requests 
handled at a single point i.e. a Load Balancer. The Load Balancer will accept all the 
requests and forward it to appropriate server(based on load on server and some 
other criteria)  
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Single server 

 

Setup with a Load Balancer 
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Note: Why is this relevant will become clear in some time. 

Configuring the Session Modes 
Using In-Proc Session Mode 

If we are using In-Proc session handling then all the session information will be 
stored in the server memory. This is the default session state in ASP.NET. 

This approach works fine as long as we are keeping small session information. 
Since the memory location was handled by the ASP.NET worker thread only it 
involves a considerable overhead for the worker thread to manage these. Also, 
since this is in the memory of server, chances are that large session information 
would lead to more memory usage and thus lowering the performance. 
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Let us try to visualize this session management technique. 

 

To configure the In-Proc session management we need to specify 
the sessionState element in theweb.config file. let us see how to configure 
the in-proc sessions 

Hide   Copy Code 

<sessionState mode="InProc"  
                stateConnectionString="tcpip=127.0.0.1:42424"  
                sqlConnectionString="Data Source=.\SQLEXPRESS;Trusted_Connection=Yes;"  
                cookieless="false"  
                timeout="100"/> 

The only relevant options for In_proc session mode in this configuration elements 
are the mode(which specifies that we are using In_proc sessions), the cookieless(if 
true, will use to manage sessions otherwise append session management data in 
the URL) and timeout(the time after which the session should expire.   

It is advisable to use the In-Proc sessions when we want very small amount of 
information in the sessions. Since the session data is stored in the memory of 
computer which is directly accessible by ASP.NET worker thread nothing extra 
needs to be done. 
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The problem with In-Proc mode session mode is that if the size of session data 
becomes large then it effects performance. Also, since the session data is in 
memory of server the application restart(ASP.NET) will effectively flush all the 
data. 

In-Proc sessions in Web Farm scenario 

As we have discussed above the web farm will have a load balancer accepting all 
the requests. It will then forward the request to any server based on some criteria. 
Lets try to see a scenario which could create problems for us if we are using In-
Proc sessions. 

 

Problem Scenario 
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1. The request from Computer1 reaches the load balancer and load balancer forwards 
it to server1. 

2. The In-Proc session led the session data created in the server1's memory. 
3. The next request comes from Computer1 and this time load balancer pushes it 

to Server2. 
4. Since the server1 had this user specific data in its memory server2 will not be able 

to recognize this request leading to failure of our application logic. 

So what should we do to tackle this situation. The whole problem was because 
each server in our web form was keeping the session data in their own memory. If 
we could somehow move this data from each server memory to a centralized 
location then we will not face this problem. And that is where 
the SQLServer and stateServercomes to rescue. using these two approaches we 
can easily configure a central repository to store session data.  

Note: There could still be some reasons(explained below) which will force you to 
use In-Proc sessions in a Web farm scenario. If this is the case then the load 
balancer should be configured to maintain connection affinity or sticky 
sessions so that the requests coming from a particular client will always be 
forwarded to the same server so that the session information can always be 
found.  

Using SQLServer Session Mode 

If we use the SqlServer mode of session management then the session data will 
be stored in the SqlServer. The benefit of having this scenario is that the data is 
stored in a centralized database rather than the server memory. Let us see how 
this can be configured from web.config 

Hide   Copy Code 

<sessionState mode="SQLServer"  
                stateConnectionString="tcpip=127.0.0.1:42424"  
                sqlConnectionString="Data Source=.\SQLEXPRESS;Trusted_Connection=Yes;"  
                cookieless="false"  
                timeout="100"/> 

Apart from this the SQLServer also needs to be configured to store the session 
data. To do that simply typeaspnet_regsql on Visual studio command prompt and 
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a configuration wizard will open. Here we can configure the SqlServer to cater 
the session data. The demo project has sqlexpress in local machine configured 
for this. To run the application, you will have to configure the sqlserver on local 
machine and perhaps change the web.config of the website. 

Note: I have given cursory step by step guide to configure SqlServer because I 
want to keep this article at conceptual level rather than becoming a "How 
To" guide.  

This way the server memory is not affected by the size of session data. Also, if we 
have a web farm then we can don't find any problem in using session data as the 
session data is in a central location. lets try to visualize this scenario 

 

Using this mode will only involve the overhead of additional database access to 
retrieve the session data. But there is one important aspect to remember when 
we are planning to use this technique. We need to send and receive the data to 
a SqlServer database, which will be a separate server. To successfully send and 
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receive the data toSqlServer all the data that is being kept in the Session has to 
be serializable. This sometimes becomes a very big issue when an application is 
being ported to web farm from a single server. That is where the load balancer's 
connection affinity will come in picture with In-Proc sessions. 

Using StateServer Session Mode 

If we use the StateServer mode of session management then the session data 
will be stored in a separate computer(server) and the session data will be handled 
by a windows service. The benefit of having this scenario is that the data is stored 
in a centralized location i.e. a state server rather than the individual server 
memory. Let us see how this can be configured from web.config 

Hide   Copy Code 

<sessionState mode="StateServer"  
                stateConnectionString="tcpip=127.0.0.1:42424"  
                sqlConnectionString="Data Source=.\SQLEXPRESS;Trusted_Connection=Yes;"  
                cookieless="false"  
                timeout="100"/> 

Apart from this the Server that will be used as state server also needs to be 
configured to store the session data. To do that simply run the service 
named ASP.NET state service to enable the desired Server to cater the session 
data. The demo project does the same on local machine configured for this. To 
run the application, you will have to run the service on local machine and perhaps 
change the web.config of the website. 

Note: I have given cursory step by step guide to configure state server on local 
machine because I want to keep this article at conceptual level rather than 
becoming a "How To" guide. 

This way the server memory is not affected by the size of session data. Also, if we 
have a web farm then we can don't find any problem in using session data as the 
session data is in a central location. lets try to visualize this scenario 
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Using this mode will only involve the overhead of network latency to retrieve the 
session data. But there is one important aspect to remember when we are 
planning to use this technique. We need to send and receive the data to a state 
server. To successfully send and receive the data to the state server all the data 
that is being kept in the Session has to be serializable. This sometimes becomes 
a very big issue when an application is being ported to web farm from a single 
server. That is where the load balancer's connection affinity will come in picture 
with In-Proc sessions. 

Using the code 
The test application contains 3 web sites with single page each. functionality wise 
all the web sites are doing the same thing but each of then is using a different 
session management technique. 
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To run all three websites the Sqlserver on local machine has to be configured to 
store session specific data(details above in the respective category) and the 
ASP.NET state service should be running on local machine. Also, 
the connectionstring will have to be modified accordingly to use the database on 
the running computer. 

Note: Please refer the web.config of each website to get the subtle difference. 

The application while running will look like: 
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WHAT IS A WEB.CONFIG FILE? 

A web.config file lets you customize the way your site or a specific 
directory on your site behaves. For example, if you place a web.config 
file in your root directory, it will affect your entire site 
(www.coolexample.com). If you place it in a /content directory, it will 
only affect that directory (www.coolexample.com/content). However, in 
order for a web.config file to register in a specific directory, there must 
be a web.config file in the root directory. 

web.config files work on our Windows servers. 

Using a web.config file, you can control: 

x Database connection strings. 

x Error behavior. 

x Security. 

 
ASP.NET - Configuration 

 The behavior of an ASP.NET application is affected by different settings in 

the configuration files: 

x machine.config 

x web.config 

The machine.config file contains default and the machine-specific value for 

all supported settings. The machine settings are controlled by the system 

administrator and applications are generally not given access to this file. 
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An application however, can override the default values by creating 

web.config files in its roots folder. The web.config file is a subset of the 

machine.config file. 

If the application contains child directories, it can define a web.config file for 

each folder. Scope of each configuration file is determined in a hierarchical 

top-down manner. 

Any web.config file can locally extend, restrict, or override any settings 

defined on the upper level. 

Visual Studio generates a default web.config file for each project. An 

application can execute without a web.config file, however, you cannot 

debug an application without a web.config file. 

The following figure shows the Solution Explorer for the sample example 

used in the web services tutorial: 
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In this application, there are two web.config files for two projects i.e., the 

web service and the web site calling the web service. 

The web.config file has the configuration element as the root node. 

Information inside this element is grouped into two main areas: the 

configuration section-handler declaration area, and the configuration section 

settings area. 

The following code snippet shows the basic syntax of a configuration file: 

<configuration> 

 

   <!-- Configuration section-handler declaration area. --> 

      <configSections> 

         <section name="section1" type="section1Handler" /> 
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         <section name="section2" type="section2Handler" /> 

      </configSections> 

   <!-- Configuration section settings area. --> 

    

   <section1> 

      <s1Setting1 attribute1="attr1" /> 

   </section1> 

    

   <section2> 

      <s2Setting1 attribute1="attr1" /> 

   </section2> 

    

   <system.web> 

      <authentication mode="Windows" /> 

   </system.web> 

    

</configuration> 

Configuration Section Handler declarations 
The configuration section handlers are contained within the 

<configSections> tags. Each configuration handler specifies name of a 

configuration section, contained within the file, which provides some 

configuration data. It has the following basic syntax: 

<configSections> 

   <section /> 

   <sectionGroup /> 
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   <remove /> 

   <clear/> 

</configSections> 

It has the following elements: 

x Clear - It removes all references to inherited sections and 

section groups. 

x Remove - It removes a reference to an inherited section and 

section group. 

x Section - It defines an association between a configuration 

section handler and a configuration element. 

x Section group - It defines an association between a 

configuration section handler and a configuration section. 

Application Settings 
The application settings allow storing application-wide name-value pairs for 

read-only access. For example, you can define a custom application setting 

as: 

<configuration> 

   <appSettings> 

      <add key="Application Name" value="MyApplication" />  

   </appSettings> 

</configuration> 

For example, you can also store the name of a book and its ISBN number: 

<configuration> 
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   <appSettings> 

      <add key="appISBN" value="0-273-68726-3" /> 

      <add key="appBook" value="Corporate Finance" /> 

   </appSettings> 

</configuration> 

Connection Strings 
The connection strings show which database connection strings are 

available to the website. For example: 

<connectionStrings> 

   <add name="ASPDotNetStepByStepConnectionString"  

      connectionString="Provider=Microsoft.Jet.OLEDB.4.0; 

      Data Source=E:\\projects\datacaching\ / 

      datacaching\App_Data\ASPDotNetStepByStep.mdb" 

      providerName="System.Data.OleDb" /> 

       

   <add name="booksConnectionString"  

      connectionString="Provider=Microsoft.Jet.OLEDB.4.0; 

      Data Source=C:\ \databinding\App_Data\books.mdb" 

      providerName="System.Data.OleDb" /> 

</connectionStrings> 

System.Web Element 
The system.web element specifies the root element for the ASP.NET 

configuration section and contains configuration elements that configure 

ASP.NET Web applications and control how the applications behave. 

www.studentsfocus.com



Sri Vidya College of  Engineering & Technology   Course Material [Lecture Notes] 

CS6001 C# AND .NET PROGRAMMING  Unit IV 

It holds most of the configuration elements needed to be adjusted in 

common applications. The basic syntax for the element is as given: 

<system.web>  

   <anonymousIdentification>  

   <authentication>  

   <authorization>  

   <browserCaps>  

   <caching>  

   <clientTarget>  

   <compilation>  

   <customErrors>  

   <deployment>  

   <deviceFilters>  

   <globalization>  

   <healthMonitoring>  

   <hostingEnvironment>  

   <httpCookies>  

   <httpHandlers>  

   <httpModules>  

   <httpRuntime>  

   <identity>  

   <machineKey>  

   <membership>  

   <mobileControls>  

   <pages>  

   <processModel>  
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   <profile>  

   <roleManager>  

   <securityPolicy>  

   <sessionPageState>  

   <sessionState>  

   <siteMap>  

   <trace>  

   <trust>  

   <urlMappings>  

   <webControls>  

   <webParts>  

   <webServices>  

   <xhtmlConformance>  

</system.web> 

The following table provides brief description of some of common sub 

elements of the system.web element: 

AnonymousIdentification 

This is required to identify users who are not authenticated when 

authorization is required. 

Authentication 

It configures the authentication support. The basic syntax is as given: 

<authentication mode="[Windows|Forms|Passport|None]">  

   <forms>...</forms> 

   <passport/> 

</authentication> 
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Authorization 

It configures the authorization support. The basic syntax is as given: 

<authorization>  

   <allow .../> 

   <deny .../> 

</authorization> 

Caching 

It Configures the cache settings. The basic syntax is as given: 

<caching> 

   <cache>...</cache> 

   <outputCache>...</outputCache> 

   <outputCacheSettings>...</outputCacheSettings> 

   <sqlCacheDependency>...</sqlCacheDependency> 

</caching> 

CustomErrors 

It defines custom error messages. The basic syntax is as given: 

<customErrors defaultRedirect="url" mode="On|Off|RemoteOnly"> 

   <error. . ./> 

</customErrors> 

Deployment 

It defines configuration settings used for deployment. The basic syntax is as 

follows: 

<deployment retail="true|false" /> 
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HostingEnvironment 

It defines configuration settings for hosting environment. The basic syntax 

is as follows: 

<hostingEnvironment idleTimeout="HH:MM:SS" 
shadowCopyBinAssemblies="true|false"  

   shutdownTimeout="number" urlMetadataSlidingExpiration="HH:MM:SS" /> 

Identity 

It configures the identity of the application. The basic syntax is as given: 

<identity impersonate="true|false" userName="domain\username" 

   password="<secure password>"/> 

MachineKey 

It configures keys to use for encryption and decryption of Forms 

authentication cookie data. 

It also allows configuring a validation key that performs message 

authentication checks on view-state data and forms authentication tickets. 

The basic syntax is: 

<machineKey validationKey="AutoGenerate,IsolateApps" [String] 

   decryptionKey="AutoGenerate,IsolateApps" [String] 

   validation="HMACSHA256" [SHA1 | MD5 | 3DES | AES | HMACSHA256 |  

   HMACSHA384 | HMACSHA512 | alg:algorithm_name] 

   decryption="Auto" [Auto | DES | 3DES | AES | alg:algorithm_name] 

/> 
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Membership 

This configures parameters of managing and authenticating user accounts. 

The basic syntax is: 

<membership defaultProvider="provider name" 

   userIsOnlineTimeWindow="number of minutes" hashAlgorithmType="SHA1"> 

   <providers>...</providers> 

</membership> 

Pages 

It provides page-specific configurations. The basic syntax is: 

<pages asyncTimeout="number" autoEventWireup="[True|False]" 

      buffer="[True|False]" clientIDMode="[AutoID|Predictable|Static]" 

      compilationMode="[Always|Auto|Never]"  

      controlRenderingCompatibilityVersion="[3.5|4.0]" 

      enableEventValidation="[True|False]" 

      enableSessionState="[True|False|ReadOnly]" 

      enableViewState="[True|False]" 

      enableViewStateMac="[True|False]" 

      maintainScrollPositionOnPostBack="[True|False]"  

      masterPageFile="file path"  

      maxPageStateFieldLength="number"  

      pageBaseType="typename, assembly" 

      pageParserFilterType="string"  

      smartNavigation="[True|False]" 

      styleSheetTheme="string" 

      theme="string" 
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      userControlBaseType="typename" 

      validateRequest="[True|False]" 

      viewStateEncryptionMode="[Always|Auto|Never]" > 

    

   <controls>...</controls> 

   <namespaces>...</namespaces> 

   <tagMapping>...</tagMapping> 

   <ignoreDeviceFilters>...</ignoreDeviceFilters> 

</pages> 

Profile 

It configures user profile parameters. The basic syntax is: 

<profile enabled="true|false" inherits="fully qualified type reference" 

   automaticSaveEnabled="true|false" defaultProvider="provider name"> 

    

   <properties>...</properties> 

   <providers>...</providers> 

    

</profile> 

RoleManager 

It configures settings for user roles. The basic syntax is: 

<roleManager cacheRolesInCookie="true|false" cookieName="name" 

   cookiePath="/" cookieProtection="All|Encryption|Validation|None" 

   cookieRequireSSL="true|false " cookieSlidingExpiration="true|false " 

   cookieTimeout="number of minutes" createPersistentCookie="true|false" 

   defaultProvider="provider name" domain="cookie domain">  
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   enabled="true|false" 

   maxCachedResults="maximum number of role names cached" 

    

   <providers>...</providers> 

</roleManager> 

SecurityPolicy 

It configures the security policy. The basic syntax is: 

<securityPolicy> 

   <trustLevel /> 

</securityPolicy> 

UrlMappings 

It defines mappings to hide the original URL and provide a more user 

friendly URL. The basic syntax is: 

<urlMappings enabled="true|false"> 

   <add.../> 

   <clear /> 

   <remove.../> 

</urlMappings> 

WebControls 

It provides the name of shared location for client scripts. The basic syntax 

is: 

<webControls clientScriptsLocation="String" /> 

WebServices 

This configures the web services. 
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 Web Services Tutorial 
 Web services are open standard (XML, SOAP, HTTP etc.) based Web 

applications that interact with other web applications for the purpose of 

exchanging data. 

Web Services can convert your existing applications into Web-applications. 

In this tutorial you will learn what exactly Web Services are and Why and 

How to use them. 

Audience 
This tutorial will be useful for all those readers inclined to learn the basics of 

web services and implement them in practice. 

Prerequisites 
This is an elementary tutorial that introduces the concepts of web services. 

It does not require the readers to have a prior knowledge of any technology 

in particular, however it would certainly make you comfortable if you have a 

basic understanding of XML, HTTP, TCP/IP concepts. 

 What are Web Services? 
 Different books and different organizations provide different definitions to 

Web Services. Some of them are listed here. 

x A web service is any piece of software that makes itself available 

over the internet and uses a standardized XML messaging 

system. XML is used to encode all communications to a web 

service. For example, a client invokes a web service by sending 

an XML message, then waits for a corresponding XML response. 

As all communication is in XML, web services are not tied to any 
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one operating system or programming language--Java can talk 

with Perl; Windows applications can talk with Unix applications. 

x Web services are self-contained, modular, distributed, dynamic 

applications that can be described, published, located, or 

invoked over the network to create products, processes, and 

supply chains. These applications can be local, distributed, or 

web-based. Web services are built on top of open standards 

such as TCP/IP, HTTP, Java, HTML, and XML. 

x Web services are XML-based information exchange systems that 

use the Internet for direct application-to-application interaction. 

These systems can include programs, objects, messages, or 

documents. 

x A web service is a collection of open protocols and standards 

used for exchanging data between applications or systems. 

Software applications written in various programming languages 

and running on various platforms can use web services to 

exchange data over computer networks like the Internet in a 

manner similar to inter-process communication on a single 

computer. This interoperability (e.g., between Java and Python, 

or Windows and Linux applications) is due to the use of open 

standards. 

To summarize, a complete web service is, therefore, any service that: 

x Is available over the Internet or private (intranet) networks 

x Uses a standardized XML messaging system 
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x Is not tied to any one operating system or programming 

language 

x Is self-describing via a common XML grammar 

x Is discoverable via a simple find mechanism 

Components of Web Services 
The basic web services platform is XML + HTTP. All the standard web 

services work using the following components 

x SOAP (Simple Object Access Protocol) 

x UDDI (Universal Description, Discovery and Integration) 

x WSDL (Web Services Description Language) 

All these components have been discussed in the Web Services 

Architecturechapter. 

How Does a Web Service Work? 
A web service enables communication among various applications by using 

open standards such as HTML, XML, WSDL, and SOAP. A web service takes 

the help of: 

x XML to tag the data 

x SOAP to transfer a message 

x WSDL to describe the availability of service. 

You can build a Java-based web service on Solaris that is accessible from 

your Visual Basic program that runs on Windows. 

You can also use C# to build new web services on Windows that can be 

invoked from your web application that is based on JavaServer Pages (JSP) 

and runs on Linux. 
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Example 
Consider a simple account-management and order processing system. The 

accounting personnel use a client application built with Visual Basic or JSP 

to create new accounts and enter new customer orders. 

The processing logic for this system is written in Java and resides on a 

Solaris machine, which also interacts with a database to store information. 

The steps to perform this operation are as follows: 

x The client program bundles the account registration information 

into a SOAP message. 

x This SOAP message is sent to the web service as the body of an 

HTTP POST request. 

x The web service unpacks the SOAP request and converts it into a 

command that the application can understand. 

x The application processes the information as required and 

responds with a new unique account number for that customer. 

x Next, the web service packages the response into another SOAP 

message, which it sends back to the client program in response 

to its HTTP request. 

x The client program unpacks the SOAP message to obtain the 

results of the account registration process. 

 Why Web Services? 
 Here are the benefits of using Web Services: 
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Exposing the Existing Function on the network 
A web service is a unit of managed code that can be remotely invoked using 
HTTP, that is, it can be activated using HTTP requests. Web services allows 
you to expose the functionality of your existing code over the network. 
Once it is exposed on the network, other application can use the 
functionality of your program. 

Interoperability 
Web services allow various applications to talk to each other and share data 
and services among themselves. Other applications can also use the web 
services. For example, a VB or .NET application can talk to Java web 
services and vice versa. Web services are used to make the application 
platform and technology independent. 

Standardized Protocol 
Web services use standardized industry standard protocol for the 
communication. All the four layers (Service Transport, XML Messaging, 
Service Description, and Service Discovery layers) use well-defined 
protocols in the web services protocol stack. This standardization of protocol 
stack gives the business many advantages such as a wide range of choices, 
reduction in the cost due to competition, and increase in the quality. 

Low Cost of Communication 
Web services use SOAP over HTTP protocol, so you can use your existing 
low-cost internet for implementing web services. This solution is much less 
costly compared to proprietary solutions like EDI/B2B. Besides SOAP over 
HTTP, web services can also be implemented on other reliable transport 
mechanisms like FTP. 

 Web Services - Characteristics 
 Web services have the following special behavioral characteristics: 
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XML-Based 
Web Services uses XML at data representation and data transportation 
layers. Using XML eliminates any networking, operating system, or platform 
binding. Web Services based applications are highly interoperable 
application at their core level. 

Loosely Coupled 
A consumer of a web service is not tied to that web service directly. The 
web service interface can change over time without compromising the 
client's ability to interact with the service. A tightly coupled system implies 
that the client and server logic are closely tied to one another, implying that 
if one interface changes, the other must be updated. Adopting a loosely 
coupled architecture tends to make software systems more manageable and 
allows simpler integration between different systems. 

Coarse-Grained 
Object-oriented technologies such as Java expose their services through 
individual methods. An individual method is too fine an operation to provide 
any useful capability at a corporate level. Building a Java program from 
scratch requires the creation of several fine-grained methods that are then 
composed into a coarse-grained service that is consumed by either a client 
or another service. 

Businesses and the interfaces that they expose should be coarse-grained. 
Web services technology provides a natural way of defining coarse-grained 
services that access the right amount of business logic. 

Ability to be Synchronous or Asynchronous 
Synchronicity refers to the binding of the client to the execution of the 
service. In synchronous invocations, the client blocks and waits for the 
service to complete its operation before continuing. Asynchronous 
operations allow a client to invoke a service and then execute other 
functions. 
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Asynchronous clients retrieve their result at a later point in time, while 
synchronous clients receive their result when the service has completed. 
Asynchronous capability is a key factor in enabling loosely coupled systems. 

Supports Remote Procedure Calls(RPCs) 
Web services allow clients to invoke procedures, functions, and methods on 
remote objects using an XML-based protocol. Remote procedures expose 
input and output parameters that a web service must support. 

Component development through Enterprise JavaBeans (EJBs) and .NET 
Components has increasingly become a part of architectures and enterprise 
deployments over the past couple of years. Both technologies are 
distributed and accessible through a variety of RPC mechanisms. 

A web service supports RPC by providing services of its own, equivalent to 
those of a traditional component, or by translating incoming invocations 
into an invocation of an EJB or a .NET component. 

Supports Document Exchange 
One of the key advantages of XML is its generic way of representing not 
only data, but also complex documents. These documents can be as simple 
as representing a current address, or they can be as complex as 
representing an entire book or Request for Quotation (RFQ). Web services 
support the transparent exchange of documents to facilitate business 
integration. 

 Web Services - Architecture 
 There are two ways to view the web service architecture: 

x The first is to examine the individual roles of each web service 

actor. 

x The second is to examine the emerging web service protocol 

stack. 
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Web Service Roles 
There are three major roles within the web service architecture: 

Service Provider 

This is the provider of the web service. The service provider implements the 

service and makes it available on the Internet. 

Service Requestor 

This is any consumer of the web service. The requestor utilizes an existing 

web service by opening a network connection and sending an XML request. 

Service Registry 

This is a logically centralized directory of services. The registry provides a 

central place where developers can publish new services or find existing 

ones. It therefore serves as a centralized clearing house for companies and 

their services. 

Web Service Protocol Stack 
A second option for viewing the web service architecture is to examine the 

emerging web service protocol stack. The stack is still evolving, but 

currently has four main layers. 

Service Transport 

This layer is responsible for transporting messages between applications. 

Currently, this layer includes Hyper Text Transport Protocol (HTTP), Simple 

Mail Transfer Protocol (SMTP), File Transfer Protocol (FTP), and newer 

protocols such as Blocks Extensible Exchange Protocol (BEEP). 
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XML Messaging 

This layer is responsible for encoding messages in a common XML format so 

that messages can be understood at either end. Currently, this layer 

includes XML-RPC and SOAP. 

Service Description 

This layer is responsible for describing the public interface to a specific web 

service. Currently, service description is handled via the Web Service 

Description Language (WSDL). 

Service Discovery 

This layer is responsible for centralizing services into a common registry 

and providing easy publish/find functionality. Currently, service discovery is 

handled via Universal Description, Discovery, and Integration (UDDI). 

As web services evolve, additional layers may be added and additional 

technologies may be added to each layer. 

The next chapter explains the components of web services. 

Few Words about Service Transport 
The bottom of the web service protocol stack is service transport. This layer 

is responsible for actually transporting XML messages between two 

computers. 

Hyper Text Transfer Protocol (HTTP) 

Currently, HTTP is the most popular option for service transport. HTTP is 

simple, stable, and widely deployed. Furthermore, most firewalls allow HTTP 

traffic. This allows XML-RPC or SOAP messages to masquerade as HTTP 

messages. This is good if you want to integrate remote applications, but it 

does raise a number of security concerns. 
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Blocks Extensible Exchange Protocol (BEEP) 

This is a promising alternative to HTTP. BEEP is a new Internet Engineering 

Task Force (IETF) framework for building new protocols. BEEP is layered 

directly on TCP and includes a number of built-in features, including an 

initial handshake protocol, authentication, security, and error handling. 

Using BEEP, one can create new protocols for a variety of applications, 

including instant messaging, file transfer, content syndication, and network 

management. 

SOAP is not tied to any specific transport protocol. In fact, you can use 

SOAP via HTTP, SMTP, or FTP. One promising idea is therefore to use SOAP 

over BEEP. 

 Web Services - Components 
 Over the past few years, three primary technologies have emerged as 

worldwide standards that make up the core of today's web services 

technology. These technologies are discussed below. 

XML-RPC 
This is the simplest XML-based protocol for exchanging information between 

computers. 

x XML-RPC is a simple protocol that uses XML messages to perform 

RPCs. 

x Requests are encoded in XML and sent via HTTP POST. 

x XML responses are embedded in the body of the HTTP response. 

x XML-RPC is platform-independent. 

x XML-RPC allows diverse applications to communicate. 

x A Java client can speak XML-RPC to a Perl server. 
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x XML-RPC is the easiest way to get started with web services. 

To learn more about XML-RPC, visit our XML-RPC Tutorial . 

SOAP 
SOAP is an XML-based protocol for exchanging information between 

computers. 

x SOAP is a communication protocol. 

x SOAP is for communication between applications. 

x SOAP is a format for sending messages. 

x SOAP is designed to communicate via Internet. 

x SOAP is platform independent. 

x SOAP is language independent. 

x SOAP is simple and extensible. 

x SOAP allows you to get around firewalls. 

x SOAP will be developed as a W3C standard. 

To learn more about SOAP, visit our SOAP Tutorial. 

WSDL 
WSDL is an XML-based language for describing web services and how to 

access them. 

x WSDL stands for Web Services Description Language. 

x WSDL was developed jointly by Microsoft and IBM. 

x WSDL is an XML based protocol for information exchange in 

decentralized and distributed environments. 

x WSDL is the standard format for describing a web service. 
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x WSDL definition describes how to access a web service and what 

operations it will perform. 

x WSDL is a language for describing how to interface with XML-

based services. 

x WSDL is an integral part of UDDI, an XML-based worldwide 

business registry. 

x WSDL is the language that UDDI uses. 

x WSDL is pronounced as 'wiz-dull' and spelled out as 'W-S-D-L'. 

To learn more about WSDL, visit our WSDL Tutorial. 

UDDI 
UDDI is an XML-based standard for describing, publishing, and finding web 

services. 

x UDDI stands for Universal Description, Discovery, and 

Integration. 

x UDDI is a specification for a distributed registry of web services. 

x UDDI is platform independent, open framework. 

x UDDI can communicate via SOAP, CORBA, and Java RMI 

Protocol. 

x UDDI uses WSDL to describe interfaces to web services. 

x UDDI is seen with SOAP and WSDL as one of the three 

foundation standards of web services. 
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x UDDI is an open industry initiative enabling businesses to 

discover each other and define how they interact over the 

Internet. 

 Web Services - Examples 
 Based on the web service architecture, we create the following two 

components as a part of web services implementation: 

Service Provider or Publisher 
This is the provider of the web service. The service provider implements the 

service and makes it available on the Internet or intranet. 

We will write and publish a simple web service using .NET SDK. 

Service Requestor or Consumer 
This is any consumer of the web service. The requestor utilizes an existing 

web service by opening a network connection and sending an XML request. 

We will also write two web service requestors: one web-based consumer 

(ASP.NET application) and another Windows application-based consumer. 

Given below is our first web service example which works as a service 

provider and exposes two methods (add and SayHello) as the web services 

to be used by applications. This is a standard template for a web service. 

.NET web services use the .asmx extension. Note that a method exposed as 

a web service has the WebMethod attribute. Save this file as 

FirstService.asmx in the IIS virtual directory (as explained in configuring 

IIS; for example, c:\MyWebSerces). 

FirstService.asmx 

<%@ WebService language = "C" class = "FirstService" %> 
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using System; 

using System.Web.Services; 

using System.Xml.Serialization; 

 

[WebService(Namespace="http://localhost/MyWebServices/")] 

public class FirstService : WebService 

{ 

   [WebMethod] 

   public int Add(int a, int b) 

   { 

      return a + b; 

   } 

 

   [WebMethod] 

   public String SayHello() 

   { 

   return "Hello World"; 

   } 

} 

To test a web service, it must be published. A web service can be published 

either on an intranet or the Internet. We will publish this web service on IIS 

running on a local machine. Let us start with configuring the IIS. 

x Open Start → Settings → Control Panel → Administrative tools → 

Internet Services Manager. 
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x Expand and right-click on the default web site; select New → 

Virtual Directory. The Virtual Directory Creation Wizard opens. 

Click Next. 

x The "Virtual Directory Alias" screen opens. Type the virtual 

directory name. For example, MyWebServices. and click Next. 

x The "Web Site Content Directory" screen opens. 

x Enter the directory path name for the virtual directory. For 

example, c:\MyWebServices Click Next. 

x The "Access Permission" screen opens. Change the settings as 

per your requirements. Let us keep the default settings for this 

exercise. 

x Click the Next button. It completes the IIS configuration. 

x Click Finish to complete the configuration. 

To test whether the IIS has been configured properly, copy an HTML file 

(For example, x.html) in the virtual directory (C:\MyWebServices) created 

above. Now, open Internet Explorer and type 

http://localhost/MyWebServices/x.html. It should open the x.html file. 

Note: If it does not work, try replacing the localhost with the IP address of 

your machine. If it still does not work, check whether IIS is running; you 

may need to reconfigure the IIS and the Virtual Directory. 

To test this web service, copy FirstService.asmx in the IIS virtual directory 

created above (C:\MyWebServices). Open the web service in Internet 

Explorer (http://localhost/MyWebServices/FirstService.asmx). It should 

open your web service page. The page should have links to two methods 
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exposed as web services by our application. Congratulations! You have 

written your first web service! 

Testing the Web Service 
As we have just seen, writing web services is easy in the .NET Framework. 

Writing web service consumers is also easy in the .NET framework; 

however, it is a bit more involved. As said earlier, we will write two types of 

service consumers, one web-based and another Windows application-based 

consumer. Let us write our first web service consumer. 

Web-Based Service Consumer 

Write a web-based consumer as given below. Call it WebApp.aspx. Note 

that it is an ASP.NET application. Save this in the virtual directory of the 

web service (c:\MyWebServices\WebApp.axpx). 

This application has two text fields that are used to get numbers from the 

user to be added. It has one button, Execute, that when clicked gets the 

Add and SayHello web services. 

WebApp.axpx 

<%@ Page Language="C#" %> 

<script runat="server"> 

   void runSrvice_Click(Object sender, EventArgs e){ 

      FirstService mySvc = new FirstService(); 

      Label1.Text = mySvc.SayHello(); 

      Label2.Text = mySvc.Add(Int32.Parse(txtNum1.Text),  
Int32.Parse(txtNum2.Text)).ToString(); 

   } 

</script> 
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<html> 

   <head> </head> 

    

   <body> 

      <form runat="server"> 

         <p> 

            <em>First Number to Add </em>: 

            <asp:TextBox id="txtNum1" runat="server" Width="43px">4<  
/asp:TextBox> 

         </p> 

    

         <p> 

            <em>Second Number To Add </em>: 

            <asp:TextBox id="txtNum2" runat="server" 
Width="44px">5</asp:TextBox> 

         </p> 

    

         <p> 

            <strong><u>Web Service Result -</u></strong> 

         </p> 

    

         <p> 

            <em>Hello world Service</em> : 

            <asp:Label id="Label1" runat="server" Font-
Underline="True">Label< /asp:Label> 

         </p> 
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         <p> 

            <em>Add Service</em> : 

            & <asp:Label id="Label2" runat="server" Font-
Underline="True">Label</asp:Label> 

         </p> 

    

         <p align="left"> 

            <asp:Button id="runSrvice" onclick="runSrvice_Click" 
runat="server"  Text="Execute"></asp:Button> 

         </p> 

    

      </form> 

       

   </body> 

</html> 

After the consumer is created, we need to create a proxy for the web 

service to be consumed. This work is done automatically by Visual Studio 

.NET for us when referencing a web service that has been added. Here are 

the steps to be followed: 

x Create a proxy for the Web Service to be consumed. The proxy is 

created using the WSDL utility supplied with the .NET SDK. This 

utility extracts information from the Web Service and creates a 

proxy. The proxy is valid only for a particular Web Service. If 

you need to consume other Web Services, you need to create a 

proxy for this service as well. Visual Studio .NET creates a proxy 

automatically for you when the Web Service reference is added. 

Create a proxy for the Web Service using the WSDL utility 

www.studentsfocus.com



  Course Material [Lecture Notes] 

CS6001 C# AND .NET PROGRAMMING  Unit IV 

supplied with the .NET SDK. It will create FirstSevice.cs file in 

the current directory. We need to compile it to create 

FirstService.dll (proxy) for the Web Service. 

x c:> WSDL http://localhost/MyWebServices/FirstService.asmx?WSDL 

x c:> csc /t:library FirstService.cs 

x Put the compiled proxy in the bin directory of the virtual directory 

of the Web Service (c:\MyWebServices\bin). Internet Information 

Services IIS looks for the proxy in this directory. 

x Create the service consumer, in the same way we already did. 

Note that an object of the Web Service proxy is instantiated in 

the consumer. This proxy takes care of interacting with the 

service. 

x Type the URL of the consumer in IE to test it (for example, 

http://localhost/MyWebServices/WebApp.aspx). 

Windows Application-Based Web Service Consumer 

Writing a Windows application-based web service consumer is the same as 

writing any other Windows application. You only need to create the proxy 

(which we have already done) and reference this proxy when compiling the 

application. Following is our Windows application that uses the web service. 

This application creates a web service object (of course, proxy) and calls 

the SayHello, and Add methods on it. 

WinApp.cs 

using System; 

using System.IO; 

 

namespace SvcConsumer { 

WWW.STUDENTSFOCUS.COM
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   class SvcEater { 

    

      public static void Main(String[] args) { 

         FirstService mySvc = new FirstService(); 

         Console.WriteLine("Calling Hello World Service: " + 
mySvc.SayHello()); 

         Console.WriteLine("Calling Add(2, 3) Service: " + mySvc.Add(2, 
3).ToString()); 

      } 

   } 

} 

Compile it using c:\>csc /r:FirstService.dll WinApp.cs. It will create 

WinApp.exe. Run it to test the application and the web service. 

Now, the question arises: How can you be sure that this application is 

actually calling the web service? 

It is simple to test. Stop your Web server so that the Web Service cannot 

be contacted. Now, run the WinApp application. It will fire a run-time 

exception. Now, start the web server again. It should work. 
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